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								EMurray@WahlRef.com
							

							User
	Posts: 1
	Joined: Tue Jan 02, 2018 8:13 pm



		
						

						
						v7 UI is so BIG there is no work area
		


														
							
								Quote
							
						


							
						
									
						Post
					
								by EMurray@WahlRef.com » Tue Jan 02, 2018 8:34 pm
			

			
			
			
			My users are complaining about the recent upgrade to v7. It is bad enough that you've relocated functions that they used daily, but the UI takes up most of the screen.
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Switching to classic is not better as it takes up the same amount of space. There needs to be a smaller tighter option.
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								Timur Born
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	Posts: 874
	Joined: Tue Jun 26, 2012 1:50 pm



		
						

						
						Re: v7 UI is so BIG there is no work area
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						Post
					
								by Timur Born » Tue Jan 02, 2018 8:47 pm
			

			
			
			
			The main problem is with those icons where you get 3 in one column. These make using the "Small Icons" option rather useless, because they dictate the minimum height of the UI bar. Of course you can set the UI to only show up when you need it, though.
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						Re: v7 UI is so BIG there is no work area
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						Post
					
								by Patrick-Tracker Supp » Tue Jan 02, 2018 8:49 pm
			

			
			
			
			Hello, 

Thank you for your post and welcome to our forums. We apologise for the inconvenience that may have been caused. 

Under File> Preferences (Edit> Preferences in classic UI)> General please change the UI scaling to System Scale, then restart the Editor. You should find that the resolution is better.



Failing that, please let us know what Scale and Layout settings are shown under display settings in windows.



Thank you!


			
			
									
													If posting files to this forum, you must archive the files to a ZIP, RAR or 7z file or they will not be uploaded.

Thank you.



Cheers,



Patrick Charest

Tracker Support North America
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								Arnold
							

							User
	Posts: 869
	Joined: Tue Jun 09, 2009 3:53 am
	Location: Florida



		
						

						
						Re: v7 UI is so BIG there is no work area
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						Post
					
								by Arnold » Wed Jan 03, 2018 2:59 pm
			

			
			
			
			Both UI's are very adjustable and can be minimized to be out of the way. I use the Classic UI, most of the time with just the Title Bar visible. I added my most used commands to the two toolbars on each end of the Title Bar. F9 toggles visibility of the Menu (Classic UI), F8 toggles visibility of all tool panes. If I press F8 another row of toolbars and the document toolbars at the bottom become visible. Still a lot of work area even with those visible.



Similar things can be done with the Ribbon UI. The Ribbon itself should reduce to 1 line when you click back in the document. At their most minimized, the Ribbon & Classic UI's look the same. I don't think F9 has any effect on the Ribbon UI. All shortcut keys can be changed to whatever you desire them to be. Each icon can have multiple shortcut keys. You can export and import your settings.
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	Location: London
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						Re: v7 UI is so BIG there is no work area
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						Post
					
								by Tracker Supp-Stefan » Wed Jan 03, 2018 3:05 pm
			

			
			
			
			Thanks for your input Arnold!



Indeed the UI is very customizable, so it can be made as minimalistic or as expansive as you like, and make you utilize your scree area in the best possible way!



I hope all of the above posts will help you get the Editor UI to the state you need it Murray!



Regards,

Stefan
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						Re: v7 UI is so BIG there is no work area
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						Post
					
								by Seeker45 » Wed Jan 03, 2018 3:09 pm
			

			
			
			
			Out of curiosity: Can the tool bars, at least the ribbon, be moved to the side and become vertical bars? Given the 16:9 ratio of many screens today, users are typically faced with a issue regarding the available vertical height but not regarding the available horizontal width.
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						Re: v7 UI is so BIG there is no work area
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								by Tracker Supp-Stefan » Wed Jan 03, 2018 3:11 pm
			

			
			
			
			Hello Seeker45,



No it is not currently possible, though I will ask on the next meeting if it is something that can be added to the features request list!



Cheers,

Stefan
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						Re: v7 UI is so BIG there is no work area
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						Post
					
								by Paul - Tracker Supp » Wed Jan 03, 2018 3:14 pm
			

			
			
			
			Nice one Arnold!



I really like your "minimum classic" version.  [image: :-)]



I believe also that we will be introducing scaling icons based on screen resolution.  It is hard to please everyone but we are doing what we can.  There are threads on this forum complaining of the opposite, that the icons are too small.



hth


			
			
									
													Best regards



Paul O'Rorke

Tracker Support North America

http://www.tracker-software.com
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						Re: v7 UI is so BIG there is no work area
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						Post
					
								by Arnold » Wed Jan 03, 2018 10:27 pm
			

			
			
			
			Here is where I have a 3rd row of icons become visible using an F7 shortcut key. At that point I have a lot of the features covered. Definitely anything I need to do no matter how infrequent. There is no 4th row.
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						Re: v7 UI is so BIG there is no work area
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						Post
					
								by Patrick-Tracker Supp » Wed Jan 03, 2018 11:21 pm
			

			
			
			
			Thanks Arnold [image: :D]



Another function worth noting with the Ribbon UI is that you can double-click any of the tabs in order to hide the toolbars when they are not directly in use. It does mean one more click, though I am afraid. I must agree with Paul - I really like the minimalist customization you've made! 



Cheers!


			
			
									
													If posting files to this forum, you must archive the files to a ZIP, RAR or 7z file or they will not be uploaded.

Thank you.



Cheers,



Patrick Charest

Tracker Support North America
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						Re: v7 UI is so BIG there is no work area
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								by HaPe » Wed Jan 03, 2018 11:26 pm
			

			
			
			
			I like using the quick access toolbar (I think you also call it the title bar).

Is it possible to separate icons with the help of "empty" ones like in Firefox ?

I couldn't find any special "separators" or "space bars".Maybe they are already 

available and I just don't know how to access them.

HaPe
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						Post
					
								by Patrick-Tracker Supp » Wed Jan 03, 2018 11:39 pm
			

			
			
			
			Hi Hape, 



You can add separators - simply right click and choose insert before or after! 



[image: Image]



I hope this helps!


			
			
									
													If posting files to this forum, you must archive the files to a ZIP, RAR or 7z file or they will not be uploaded.

Thank you.



Cheers,



Patrick Charest

Tracker Support North America
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						Re: v7 UI is so BIG there is no work area
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						Post
					
								by HaPe » Thu Jan 04, 2018 12:10 am
			

			
			
			
			Patrick-Tracker Supp wrote:You can add separators - simply right click and choose insert before or after! 



Thanks Patrick - that was indeed helpful !

Apart from the separators is there also a way to add "empty spaces" and if not 

would it be possible to make them available in future releases?

It's not urgent but they would help me visually a lot ... I am getting old and my eyesight is not the best anymore

(otherwise I would have found the "separators" myself.....  [image: :lol:]  )



HaPe
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						Re: v7 UI is so BIG there is no work area
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						Post
					
								by TrackerSupp-Daniel » Thu Jan 04, 2018 12:37 am
			

			
			
			
			Hey HaPE



I've made a feature request for you about that, we cannot guarantee it'll be implemented, but we can guarantee the Dev Team will seriously consider it.

Have a great day!


			
			
									
													Dan McIntyre - Support Technician

Tracker Software Products (Canada) LTD

+++++++++++++++++++++++++++++++++++

Our Web site domain and email address has changed as of 26/10/2023.

https://www.pdf-xchange.com

Support@pdf-xchange.com
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						Re: v7 UI is so BIG there is no work area
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						Post
					
								by HaPe » Thu Jan 04, 2018 12:46 am
			

			
			
			
			TrackerSupp-Daniel wrote:Hey HaPE



I've made a feature request for you about that, we cannot guarantee it'll be implemented, but we can guarantee the Dev Team will seriously consider it.

Have a great day!



Thanks Daniel & thanks Patrick for your support



HaPe
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						Post
					
								by Peter 123 » Thu Jan 04, 2018 1:58 am
			

			
			
			
			Thanks from my side too, especially to Arnold and to Patrick for the pictures you have provided.



I would also like to get some separators, please.  [image: :mrgreen:] 

So a (probably silly) question to Patrick, concerning the menu shown in your above posting ("Delete" - "Show Icon" - "Show Text" etc.):

Where must I right click to see this menu? I have tried on various places of the UI but it does not appear. 



Thank you.  [image: :wink:]
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						Re: v7 UI is so BIG there is no work area
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								by Tracker Supp-Stefan » Thu Jan 04, 2018 12:03 pm
			

			
			
			
			Hi Peter,



You need to have the "Customize Toolbars" window open first, and then just right click on any button already present in a toolbar - and you will get that context menu.

On the below image I have just right clicked on the "rotate counter clockwise" tool:
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Regards,

Stefan
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						Post
					
								by Arnold » Thu Jan 04, 2018 5:44 pm
			

			
			
			
			The questions about separators reminded me of one final thing I noticed. I was not able to add a separator at the end of a toolbar to distinguish it from a toolbar that it is docked right next to. This would be nice when toolbars are locked. When I closed Customize Toolbars the separator disappeared. Open Customize Toolbars back up and separator is still there.



Thanks.
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	3 - Normal Mode Toolbars Locked.png (1.44 KiB) Viewed 9717 times
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						Post
					
								by Patrick-Tracker Supp » Thu Jan 04, 2018 7:44 pm
			

			
			
			
			Hi Arnold, 

By default a new separator is invisible. With the customize toolbar window still open, simply right click the separator and you can change its properties: 

[image: Image]

Cheers!


			
			
									
													If posting files to this forum, you must archive the files to a ZIP, RAR or 7z file or they will not be uploaded.

Thank you.



Cheers,



Patrick Charest

Tracker Support North America
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						Re: v7 UI is so BIG there is no work area
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						Post
					
								by Peter 123 » Thu Jan 04, 2018 8:27 pm
			

			
			
			
			@ Stefan:
Tracker Supp-Stefan wrote:
You need to have the "Customize Toolbars" window open first, [...]


Ahh, this was the solution.  [image: :D] Many thanks.




Arnold wrote:I was not able to add a separator at the end of a toolbar to distinguish it from a toolbar that it is docked right next to. [...] When I closed Customize Toolbars the separator disappeared. Open Customize Toolbars back up and separator is still there.


Yes, the same here.



@ Patrick:

Your instructions for me did not work. The separators mentioned by Arnold remain invisible after closing the "Customize Toolbars" window whatever property I choose. But that's no big issue for me. Let's see what is Arnold's experience.
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								by Arnold » Thu Jan 04, 2018 8:47 pm
			

			
			
			
			Nope. Did not work over here. If I place a separator anywhere else, it is visible without me having to change any properties. Only seems to happen at the beginning and end of toolbars.



I wonder what a hard breaking separator does?
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								by HaPe » Thu Jan 04, 2018 9:09 pm
			

			
			
			
			Arnold wrote:Nope. Did not work over here. If I place a separator anywhere else, it is visible without me having to change any properties. Only seems to happen at the beginning and end of toolbars.



I wonder what a hard breaking separator does?



Good question.After knowing how to insert separators I also tried  the other options in that menu but couldn't find any advantage in using them.

Anyway:

Personally I think the separators and and also possible "empty" spaces" in future releases should be located in the same place where all the other icons cn be found

and from where users can drag and drop them to the toolbars - like in Firefox.

Also the options given in the menu "insert separator after" or "insert separator before" are not really necessary as they can be easily moved around afterwards.

But that's just my opinion - for other users it might be useful as it is.

Just to make myself clear: I am very,very happy with the new interface ! - I really like it a lot and it will be difficult to make it right for everybody.
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						Re: v7 UI is so BIG there is no work area
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								by TrackerSupp-Daniel » Thu Jan 04, 2018 10:54 pm
			

			
			
			
			I see what you mean about seperators at the ends of lines dissapearing. Ill make sure its noted, maybe put in a note to one of the other feature requests that is very similar.

About those hard breaking seperators, all it does is forces the seperator to be the same height as the main panel its in, so if you have a section like this 

[image: Image]

You can make it look like this instead

[image: Image]

Essentially to be used for spacing or the like


			
			
									
													Dan McIntyre - Support Technician

Tracker Software Products (Canada) LTD

+++++++++++++++++++++++++++++++++++

Our Web site domain and email address has changed as of 26/10/2023.

https://www.pdf-xchange.com

Support@pdf-xchange.com
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						Re: v7 UI is so BIG there is no work area
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						Post
					
								by Arnold » Fri Jan 05, 2018 9:25 am
			

			
			
			
			I fiddled around with the Ribbon UI a little when I first switched to version 7. I will ask a question I had then, based on this new knowledge about separators. In the screen shots, is the stacking of the 3 icons in the tools section by design, or because of a separator?



If it is because of a separator, then that section could conceivably be flattened out some by changing the properties of the separator. I suspect you may have it set that way and at that height permanently for uniformity when text labels are set to visible.



I don't use the Ribbon, but it seems to me it would not matter much either way as the Ribbon reduces to 1 line when you click back in the document. Just curious.
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Thanks.
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								by Timur Born » Fri Jan 05, 2018 11:02 am
			

			
			
			
			The three icons being stacked can be change to two or even just one. Just found out about that thanks to this thread here.
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						Post
					
								by Tracker Supp-Stefan » Fri Jan 05, 2018 12:09 pm
			

			
			
			
			Thank you all for the comments!



Is the issue with the separator behind the last tool disappearing still open?

Maybe adding a separator before the first tool in the next toolbar will work just as well?



Cheers,

Stefan
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								Ovg
							

							User
	Posts: 461
	Joined: Tue Sep 05, 2017 4:56 pm



		
						

						
						Re: v7 UI is so BIG there is no work area
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						Post
					
								by Ovg » Sun Jan 07, 2018 12:03 pm
			

			
			
			
			1/2 Off: It would be nice to have separators between items in  «Add-On Tools» Tab


			
			
									
													It's impossible to lead us astray for we don't care even to choose the way.

PDF-XChange PRO, 10.1.1 (Build 381) / W7 SP1 x64
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						Post
					
								by Tracker Supp-Stefan » Mon Jan 08, 2018 11:57 am
			

			
			
			
			Hi Ovg,



This toolbar is dynamically created from code - either inside a specific document, or from files you have in %APPDATA%\Tracker Software\PDFXEditor\3.0\JavaScripts, so unfortunately it is not customizable and can not be made customizable to have such separators in there.



Regards,

Stefan
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						Re: v7 UI is so BIG there is no work area
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								by StangMan65 » Mon Jan 08, 2018 3:37 pm
			

			
			
			
			I made the mistake of installing v7. Wow. The new toolbars are horrendous. So huge and ungainly that the tool is unusable in my daily work flow. Please add an option for the old toolbars, where you can turn off text and drag the lower toolbar edge upwards to make toolbars one row tall and they automatically expand to the right. I realize somebody responded in this thread about creating (essentially hacking) menus like that manually but I'm not interested. Want to see it as a native option. I'm going back to v6 for now.
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						Re: v7 UI is so BIG there is no work area
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						Post
					
								by Ovg » Mon Jan 08, 2018 3:43 pm
			

			
			
			
			Hi Stefan!

Thank you  for answer!
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			2StangMan65	
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					Last edited by Ovg on Mon Jan 08, 2018 4:31 pm, edited 1 time in total.
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			Is this what you are looking for? Takes a little time to set up, but toolbars can be nested.
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								Tracker Supp-Stefan
							

							Site Admin
	Posts: 17853
	Joined: Mon Jan 12, 2009 8:07 am
	Location: London
	
				Contact:
				
					
						Contact Tracker Supp-Stefan
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			Hi Peter,



Please take a look at the above couple posts from OVG and Arnold (Thanks for those guys!).

The UI might be "huge" at first, but it can be tweaked extensively to your liking!



I've also updated your username as requested.



Regards,

Stefan
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						Re: v7 UI is so BIG there is no work area
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			Hi, Arnold!

I'm wonder how anyone can place button into title bar?
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			Ovg wrote:2StangMan65	

https://www.pdf-xchange.com/forum3 ... 62&t=30225



Perfect. Thank you! Toolbar is nice and small again.
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			@Ovg



Is this a real question: "I'm wonder how anyone can place button into title bar?".



You can drag-and-drop commands (icons/buttons) to the title bar, just like you do for tool bars (while "Customize Toolbars" is active).
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			I found the source of the problem - Quick Access menu was accidentally closed .... BTW Thank you Willy!
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			Hello Ovg, 



Glad you found the problem. Cheers!


			
			
									
													If posting files to this forum, you must archive the files to a ZIP, RAR or 7z file or they will not be uploaded.

Thank you.



Cheers,



Patrick Charest

Tracker Support North America
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						Post
					
								by Ovg » Mon Jan 08, 2018 8:33 pm
			

			
			
			
			Tracker Supp-Stefan wrote:Hi Ovg,

This toolbar is dynamically created from code - either inside a specific document, or from files you have in %APPDATA%\Tracker Software\PDFXEditor\3.0\JavaScripts, so unfortunately it is not customizable and can not be made customizable to have such separators in there.

Regards,

Stefan


I have found tricky workaround here - adding nbsp - (Alt-0160 on numpad) to cLabel at appropriate places practically solved the problem for me.
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													If posting files to this forum - you must archive the files to a ZIP, RAR or 7z file or they will not be uploaded - thank you.



Best regards

Tracker Support

http://www.tracker-software.com
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